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Excourse Software License and Warranty

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT "LICENSE" CAREFULLY. IF YOU DO NOT AGREE TO THE TERMS OF

THIS LICENSE, RETURN THE SOFTWARE TO THE PLACE WHERE YOU OBTAINED IT FOR A REFUND (IF APPLICABLE).

1. License. The software, documentation accompanying this License whether on disk, in read only memory, on any other

media or in any other form (the “Software”) are licensed to you by Excourse. You own the media on which the Software is

recorded but Excourse and/or Excourse's licensor(s) retain title to the Software. The Software in this package and any copies

which this License authorizes you to make are subject to this License.

2. Permitted Uses and Restrictions. This License allows you to install and use the Software on a single computer at a time.

This License does not allow the Software to exist on more than one computer at a time. If you are using demonstration ver-

sion of the Software, you may use such Software on as many computers as you choose without restrictions. You may make one

copy of the Software in machine-readable form for backup purposes only. The backup copy must include all copyright infor-

mation contained on the original. Except as expressly permitted in this License, you may not decompile, reverse engineer, dis-

assemble, modify, rent, lease, loan, sublicense, distribute or create derivative works based upon the Software in whole or part

or transmit the Software over a network. THE SOFTWARE IS NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR

FACILITIES, AIRCRAFT NAVIGATION OR COMMUNICATION SYSTEMS, OR AIR TRAFFIC CONTROL MACHINES IN WHICH

CASE THE FAILURE OF THE SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR ENVIRON-

MENTAL DAMAGE. Your rights under this License will terminate automatically without notice from Excourse if you fail to

comply with any term(s) of this License.

3. Limited Warranty on Media (if applicable). In the event that you paid Excourse for the Software to be delivered on

media, then Excourse warrants the media on which the Software is recorded to be free from defects in materials and work-

manship under normal use for a period of ninety (90) days from the date of original retail purchase. Your exclusive remedy

under this paragraph shall be a replacement of the Software which is returned to Excourse or an Excourse authorized repre-

sentative with a copy of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES ON THE MEDIA INCLUD-

ING THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE LIMITED IN

DURATION TO NINETY (90) DAYS FROM THE DATE OF ORIGINAL RETAIL PURCHASE.

4. Disclaimer of Warranty on Software. You expressly acknowledge and agree that use of the Software is at your sole risk.

The Software is provided “AS IS” and without warranty of any kind and Excourse and Excourse's licensor(s) (for the purposes

of provisions 4 and 5, Excourse and Excourse's licensor(s) shall be collectively referred to as "Excourse") EXPRESSLY DIS-

CLAIM ALL WARRANTIES AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED

WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY OR SATISFACTORY QUALITY AND FITNESS FOR A PARTICU-

LAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. EXCOURSE DOES NOT WARRANT THAT THE FUNC-

TIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE

WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHER-

MORE, EXCOURSE DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF

THE USE OF THE SOFTWARE OR RELATED DOCUMENTATION IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILI-

TY, OR OTHERWISE. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY EXCOURSE OR AN EXCOURSE AUTHO-

RIZED REPRESENTATIVE SHALL CREATE A WARRANTY OR IN ANY WAY INCREASE THE SCOPE OF THIS WARRANTY.

SHOULD THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT EXCOURSE OR AN EXCOURSE AUTHORIZED REPRESENTA-

TIVE) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

5. Limitation of Liability. UNDER NO CIRCUMSTANCES, INCLUDING NEGLIGENCE, SHALL EXCOURSE BE LIABLE FOR

ANY INCIDENTAL, SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS LICENSE.

In no event shall Excourse's total liability to you for all damages exceed the amount of one US dollar ($1.00).

7. Complete Agreement. This License constitutes the entire agreement between the parties with respect to the use of the

Software and supersedes all prior or contemporaneous understandings regarding such subject matter. If any provision of this

License is found by a court of competent jurisdiction to be unenforceable for any reason, the remainder of this License shall

continue in full force and effect. No amendment to or modification of this License will be binding unless in writing and

signed by Excourse.

LibTIFF Copyright and Permission Notices

Copyright (c) 1988-1997 Sam Leffler

Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software (LibTIFF) and its documentation for any purpose is hereby

granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the soft-

ware and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or

publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE (LIBTIFF) IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHER-

WISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PUR-

POSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR

CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR

PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING

OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
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ABOUT EXCENTRO COMMANDS REFERENCE

Excentro Commands Reference book provides complete reference of all commands

of Excentro application menu bar. It is devised to be used in conjunction with accompa-

nying reference books Excentro Windows Reference, Excentro Objects Refer-

ence and Using Excentro guide.

This book is not designed to be read from cover to cover, one chapter after another,

though, of course, it could be read this way. We suggest you to use Excentro Com-

mands Reference as reference (as it name implies): when you need to look up some

command description, appropriate section of this book will give you all information you

need. Sometimes it is a good idea to read descriptions of other commands from same

chapter as well, because they can cover related matters and contain useful information

on same subject.

Mac OS 9 version of Excentro menu bar.

Mac OS X version of Excentro menu bar.

Chapters of this book are organized in same order as menus in Excentro menu bar: File

menu, Edit menu, Structure menu, Arrange menu, View menu and Window menu.

Last chapters cover: Mac OS 9 Apple menu and Mac OS X Excentro Application

menu. These are least important chapters of this reference, because they contain only

standards commands of Mac OS operating system or informational commands that does

not have practical purpose. We decided to put them there instead of the beginning of

the book, where they should be due to their order in menu bar.

■ File, Edit and Window menus are standard menus of all Macintosh applica-

tions. You probably will never look into chapters that covers these menus because

almost all commands in these menus have traditional names and functions. 

■ Arrange and View menu are similar to those of other graphics application. First

of them changes drawing order of graphics objects, second menu controls appear-

ance of graphics preview.

■ Structure menu is the only menu that contains commands unique to Excentro
application. This menu allows you to create and manage guilloche structure tree —

the content of Excentro documents. We recommend you to read this whole chap-

ter or at least to leaf through its pages looking at illustrations.

We cover both Mac OS 9 and Mac OS X versions of Excentro menus. Whenever possible

we use Mac OS 9 versions of screenshots for illustrations. There are two main reasons for

us to do so:

1. Most of those who use Mac OS X used Mac OS 9 not so long before it, so they

should be accustomed to older windows and menus look, unlike those who still

use Mac OS 9. Those who can not use Mac OS X for some reasons can be easily

confused by new Aqua appearance, so we minimized use of new windows and

menus where we could.

2. Antialiased text and transparent windows with striped background are pretty

cool features on computer screen. However older screenshots still look better

when printed on paper and produce smaller size PDF format documents.
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Type conventions used in this book are the same as in other guides and references of

Excentro application:

Bold type style is used to expose titles of windows, menu commands and other

interface elements like controls and buttons. It also is used for titles of other chap-

ters and books of Excentro guides.

Italic type style is used for names of applications, software products and names of

companies that produce them. This style is used also to show sample numeric and

string values you can enter in attribute numeric fields.

We hope this would be enough to relate the story of Excentro menu bar without using

additional typefaces and styles.

Sometimes you will encounter Comments at the end of commands description sec-

tions. You can skip these, since they do not contain information of practical value. But

you may find them interesting to look at if you have a spare minute.

Excentro Commands Reference
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CHAPTER 1: FILE MENU

File menu of Excentro application contains standard set of commands that allows you

to manage document files and windows. With these commands you can create new,

open existing, save changed and export finished Excentro documents.

File menu has different look when Excentro runs under Mac OS X and Mac OS 9 operat-

ing system versions. While running under Mac OS 9 File menu contains Quit command

item (like other Mac OS 9 applications do). To comply with new Mac OS X standards this

command was moved to Excentro Application menu, so it no longer could be found

in File menu when Excentro runs under this operating system version.

Excentro is a guilloche generating software only, you can use it to create individual guil-

loche designs for your security papers or diploma. Concluding layout tasks are supposed

to be performed with some vector-based illustration tool like Adobe Illustrator. Since

Excentro output is not a final product that will be printed for customers, the application

does not possess its own printing capabilities. Export command that saves document in

Adobe Illustrator EPS format replaces usual printing command group in File menu and

has usual printing Cmd-P shortcut. If you want to print your guilloche design, you can

export Excentro document with Export command, open it in Adobe Illustrator, add

some more graphics or text objects and print it using rich set of printing options Adobe
Illustrator offers.

Almost all commands of File menu has familiar behavior to those who used to work

with Apple Macintosh user interface standard. This chapter contains full reference of all

File menu commands, but most likely you will need to read descriptions of Place,

Document Setup and Export commands only.
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NEW…

As its name suggests, New command (Cmd-N) creates new Excentro documents. You

can use this command if you want to create completely new guilloche design not based

on any existing document or template. After you choose this command, New

Document dialog will appear where you can type new document name, select appro-

priate page format and page orientation.

Document page format and orientation define work area for new design. You can

change them at later time with Document Setup command. To define page size you

can use one of predefined formats in Page size popup menu or select Custom format

item from popup menu and type new page size using numeric Width and Height fields.

List of predefined formats in Page size popup menu could be changed in Page Size

panel of Excentro Preferences dialog.

When you finished with New Document dialog click OK button and new Excentro
document will appear in front of you. Excentro documents use two windows to display

their contents: main document window with layers list, colors list and guilloche tree

structure and preview document window with graphics preview. More details about

document windows and guilloche design creation could be found in chapters of

Excentro Windows Reference book.

As another shortcut to New command, you can use the button with blank page picture

in left part of Commands section of Toolbar.
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OPEN…

Open command (Cmd-O) opens files of Excentro documents earlier saved to disk or

creates new documents from stationary templates.

After you choose Open command, standard Mac OS Open dialog will appear in front of

you. You can use usual controls of this dialog: file list, popup menus, preview area and

buttons to locate on disk the file you want to open. (If you are using Excentro under Mac
OS X, Open dialog will look a bit differently than the picture below).

When you found right document or stationary, click Open button and the document

will be opened on your computer screen.

Let us repeat here again that Excentro documents use two windows to display their con-

tents: main document window that shows document layers, colors and guilloche tree

structure and preview document window with realistic graphics preview. Preview

magnification value and both windows display options are saved with the document

and will be used when you open it again. More details about document windows and

guilloche design creation could be found in Excentro Windows Reference book.

Toolbar shortcut to Open command is the button with open folder picture in the mid-

dle of Commands section.
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OPEN RECENT

Open Recent submenu contains list of ten last opened documents. You can use this

menu items as shortcuts for Open command to avoid locating recently opened docu-

ments with Open dialog again.

New items are added to top of this list, so the list grows bottom to top: most recent files

at top, older entries at bottom. 

If some of recently opened files gets deleted from the disk (erased or overwritten) or

network disk with these files gets disconnected, their items in the list will be removed

next time Excentro starts. You can use Clear Menu command at bottom of the list to

delete all items in the list, if you want to.

PLACE…

Place command lets you combine contents of two Excentro documents. This way you

can add to your documents ready guilloche rosettes or backgrounds from clip art library

or your previous work.

With first document opened in front of you, choose Place command and locate second

document in Mac OS file navigation dialog.
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Click Place button and content of the second document will be added to content of the

first one.

If second document has just one layer, its content is merged with content of first docu-

ment’s currently selected layer. If second document has two or more layers, these layers

are added to top of first document’s layers list as separate layers with their drawing order

and attributes preserved.

Items from color list of second document will be added to color list of first document as

well.

CLOSE

With Close command (Cmd-W) you can close Excentro documents or non-document

windows like Excentro Preferences dialog, Clipboard window or About box when

you no longer need them. This command has same effect as mouse click in window’s

close box — small button in left top corner of window toolbar (shown with circles on

picture below): the window it is used on disappears.

When this command is used on documents, both windows that belong to this document

will be closed simultaneously. If the document has unsaved changes, standard warning

dialog is displayed that gives you three choices: to save the changes you made to the

document, to discard the changes or to cancel document closing and continue working

with it.
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CLOSE ALL

When Option key is pressed title of Close command changes to Close All (Cmd-

Option-W) and choosing it will close all opened Excentro documents and non-docu-

ment windows: Excentro Preferences dialog, Clipboard window and About box.

This command has same effect as mouse click in window’s close box while Option key

is pressed.

When closing sequence comes to document with unsaved changes, standard warning is

displayed (see picture on previous page) that gives you three choices: to save changes, to

discard changes or to cancel document closing and stop whole ‘closing all’ procedure.

SAVE

You can use Save command (Cmd-S) to save to disk changes you made to Excentro
document. Excentro uses traditional floppy disk picture for Toolbar button with short-

cut to Save command.

If the document was never saved before and does not have accompanying file on disk

Save command behavior is identical to Save As… command: it allows you to specify

name and location for new file to save this document to. More details about Save As…

command see below.

SAVE AS…

Save As… command (Cmd-Shift-S) lets you to save Excentro document to disk with

new file name or to new location: another folder or different disk. You can use this com-

mand if you want to create a copy of the document before making serious modifications

to it, for example.

When you choose this command standard Mac OS Save dialog will appear, where you

can enter file name and browse disk for appropriate place to save it to. (If you are using

Excentro with Mac OS X, Save dialog will look a bit differently than the picture below).

Find location to save your document to, type new file name and click Save button.

Document windows titles and their path menus will be changed to reflect the change.
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REVERT TO SAVED

Use Revert to Saved command to discard all changes made to current Excentro docu-

ment since last time it was saved. Of course, you can revert changes one at time with

Undo command from Edit menu, but Revert to Saved command represents a faster

alternative to revert document content to last saved state.

When this command is chosen, standard warning dialog will be displayed that will ask

your confirmation to discard changes to the file, because this action can not be reverted

with Undo command or by other means.

DOCUMENT SETUP…

You can change page format and orientation of Excentro document at any time with

Document Setup… command. When you choose this command Document Setup

dialog will appear on screen in front of you.

Document setup for standard A4 certificate.
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You can select one of predefined formats from Page size popup menu. List of prede-

fined formats could be edited in Page Size panel of Excentro Preferences dialog. You

can also select Custom item from popup menu and type new page size using numeric

Width and Height fields.

Document setup for custom page design.

You can make a choice between Portrait or Landscape orientation for your document:

Width and Height fields swap their values when you change document orientation.

When you finished with Document Setup dialog click OK button and Excentro docu-

ment will be resized to new values.

EXPORT…

You will use Export… command (Cmd-P) at the final steps of your guilloche creation

process in Excentro to save ready designs in Adobe Illustrator file format. When you select

this command Mac OS file navigation dialog appears where you can type name for

exported file and select appropriate location for it.

Click Export button when you are ready and your design will be exported to Adobe
Illustrator file format. Please, see Excentro Preferences chapter of this reference for

more information about export options and how to configure these using Export panel
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of Excentro Preferences dialog. In most cases you will select some vector based

design application to open exported file immediately after export is complete.

If you will open file exported from Excentro using Adobe Illustrator application, not only

paths attributes and layers order but all preview options like graphics magnification

value, preview window’s size and screen location will be preserved.

File with guilloche graphics exported from Excentro has same window size and preview
options in Adobe Illustrator application.

The button with old Adobe Illustrator file icon serves as shortcut to Export command,

in Commands section of Toolbar.

QUIT (Mac OS 9)

You can use Quit command (Cmd-Q) to end your work with Excentro and quit the

application. This command could be found in File menu only when Excentro runs under

Mac OS 9 operating system version. Under Mac OS X this command is moved to

Excentro Application menu as new Apple interface guidelines suggest.

Before it quits, Excentro tries to close all opened documents. If closing sequence comes

to document with unsaved changes, standard warning is displayed that gives you three

choices: to save changes, to discard changes or to cancel document closing and stop

quitting procedure.
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CHAPTER 2: EDIT MENU

Edit is another standard menu every Macintosh application has. It contains commands

that perform usual editing actions like cutting, copying or pasting objects. It also allows

you to revert recent changes made to the document.

Mac OS 9 version of Edit menu has additional Preferences… command that brings to

screen application preferences dialog, this was a common behavior for Mac OS 9 appli-

cations. When Excentro runs under Mac OS X this command is moved to Excentro

Application menu, as new interface guidelines from Apple dictate. All other Edit menu

commands and their functions are identical for both Mac OS versions.

Excentro adds single command to Edit menu that is not usual for other applications:

Zap Document Undos. This command could be used to discard all previous undo-

redo states for current document. By default Excentro keeps all user actions in memory,

so you can undo-redo all earlier changes at any later time. Unfortunately this feature can

slow down application performance after few hours of work with the document, when

number of undo states goes over one thousand, or it even can cause low memory situa-

tions while running under Mac OS 9.

After this short overview let us move on to detailed description of all Edit menu com-

mands.

UNDO

Undo (Cmd-Z) command reverts recent changes made to current document. This

command name is usually longer than just ‘Undo’ and also contains name of the action

that will be reverted when this command will be chosen. For example: Undo New Base,

Undo Change Values, Undo Paste, etc.
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Excentro maintains complete list of changes that were made to the document from the

moment it was opened or created. This way you can undo almost any action at any later

time. After the action was reverted it moves from undo list to redo list and you can reap-

ply it again with Redo command (see below).

Please, be aware that there are actions that can not be reverted with Undo command.

For example: Revert to Saved command from File menu, that restore to last saved

document state, or Zap Document Undos command (see later in this chapter).

REDO

Redo command (Cmd-Shift-Z) allows you to reapply changes that were reverted with

Undo command. Just like with Undo command above, name of Redo command is usu-

ally longer than just ‘Redo’ and it also contains name of the action that will be reapplied

by this command: Redo New Base, Redo Change Values, Redo Paste, etc.

Excentro maintains complete list of changes that were reverted with Undo command,

so you can reapply them all if you need to. After the action was reapplied it gets moved

from redo list to undo list and you can revert it again with Undo command.

If after series of undo actions you made some new change to the document, redo list will

be automatically cleared according to common sense.

CUT

With Cut command (Cmd-X) you can cut selected text of editable text field or selected

object of Excentro document to Clipboard buffer. This command is identical in effect to

combination of two other commands from Edit menu: Copy (that copies selected text

or object to Clipboard buffer) and Clear (that deletes selected text or object). You can

insert text or object you cut later with Paste command.

You can not use Cut command on selected object of guilloche tree structure of Excentro
document if some other objects are dependent on it. This can happen in two following

cases:

■ Selected object has children elements. Speaking in terms used for guilloche tree

construction in Excentro ‘this element serves as base or second base to any other

elements’.

■ Selected object ‘guides direction’ of other elements or, in other words, ‘some

other elements use it as direction element’.

You should delete elements that depend on selected object or change/remove their con-

nections first.

When object of guilloche structure tree of Excentro document is cut or copied to

Clipboard, its guilloche paths are copied too as Adobe Illustrator EPS data. After that you

can switch to Adobe Illustrator or other vector-based design application and insert

copied paths from Clipboard to active document in this application with Paste com-

mand. See illustration below in section that describes Copy command.
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COPY

Copy command (Cmd-C) allows you to copy selected text of editable text field or

selected object of Excentro document to Clipboard buffer. You can insert copied text or

object later with Paste command.

When object of guilloche structure tree of Excentro document is copied to Clipboard, its

guilloche paths are copied too as Adobe Illustrator EPS data. After that you can switch to

Adobe Illustrator or other vector-based design application and insert copied paths from

Clipboard to active document in this application with Paste command.

You may want to do so if you need to transfer vector paths of selected object to Adobe
Illustrator document quickly without export of entire Excentro document.

Step 1. Excentro: selected object and its guilloche paths are copied to Clipboard buffer
with Copy command.

Step 2. Adobe Illustrator: Guilloche paths from Excentro document are inserted in active
document with Paste command.
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PASTE

With Paste command (Cmd-V) you can insert text or object of guilloche tree structure

from Clipboard buffer to Excentro document. Before using Paste command, you should

cut or copy proper text selection or object to Clipboard with Cut or Copy commands

from Edit menu.

Pasting text is rather straightforward task: place cursor anywhere in editable text filed of

Excentro document, dialog or window and choose Paste command — text from Clip-

board will be inserted where text caret was blinking.

Pasting guilloche objects has some more details and considerations to keep in mind:

■ Pasting bases: if the object copied to Clipboard is an element of base type

(‘root’ element of guilloche tree structure) you can insert it with Paste command

to this or another document or layer without any limitations.

Base element from Clipboard inserted to Excentro document with Paste command.

■ Pasting elements: if the object copied to Clipboard is regular element with

just one parent (not a ‘content element’ that has two parents), you should select

other element of guilloche tree structure before inserting it with Paste command.

This selected element will be parent or base element for new element. If element

copied to Clipboard had direction element this connection will not be preserved:

you should assign direction element for new element later with Direction->Set

command from Structure menu.

Regular element from Clipboard is inserted as child element of selected element.

■ Pasting content elements: if the object copied to Clipboard is an element

with two parents (‘content element’) you should select two other element of guil-

loche tree structure that will become base and second base elements of new
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inserted element. First element should be selected with mouse click, this element

will be base or parent element of inserted content element, second element

should be selected with mouse click with Shift key held down, this element will

become second base or second parent element of new element.

Content element from Clipboard is inserted as child element of both selected ele-
ments, if two elements were selected before Paste command is chosen.

If only one element is selected new inserted element will be regular (‘not content’)

element that will have selected element as its single parent. Type of new element

will be same as that of content element on the Clipboard. You can not insert ele-

ment of Blend type this way. Paste command will be disabled if Blend content

element is copied to Clipboard and only one element of document’s tree structure

is selected.

Content element from Clipboard is inserted as regular child element of selected ele-
ment, if only one element was selected before Paste command is chosen.

Excentro Commands Reference

Chapter 2: Edit Menu

2-5



CLEAR

Clear command deletes selected text of editable text field or selected object of Excentro
document. You, probably, will never use this command because to delete text it is more

easier to use usual keyboard keys like backspace or forward delete, and to delete selected

object in document it is more logical to use Delete Element and Delete All Elements

commands from Structure menu (or toolbar button with shortcut to these com-

mands). Clear command is provided for compatibility with other Mac OS applications

and Apple interface standards. This command is similar in effect to Cut command from

Edit menu but it does not place deleted text or object to Clipboard buffer, so you can

not insert it later.

There are no limitations on clearing editable text field contents, but, as with Cut or

Delete Element commands, you can not use Clear command on selected object of

guilloche tree structure of Excentro document if some other objects are dependent on it.

This can happen in two following cases:

■ Selected object has children elements. Speaking in terms used for guilloche tree

construction in Excentro ‘this element serves as base or second base to any other

elements’. You may use Delete All Elements from Structure menu to delete

selected object and all its children elements (see description of this command in

next chapter of this reference).

■ Selected object ‘guides direction’ of other elements or, in other words, ‘some

other elements use it as direction element’.

You should delete elements that depend on selected object or change/remove their con-

nections first.

Two bottom elements do not have other elements that depend on them. Only they could be
deleted with Clear, Cut, or Delete Element commands.
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SELECT ALL

Select All command (Cmd-A) works only with editable text fields of Excentro dialogs

and windows. It allows you to select all text in active text field: place cursor anywhere in

editable text filed and choose Select All command — whole text range of this field will

be selected.

Active text field before and after Select All command.

Select All command does not have any effect on non-text objects like layers, colors,

objects of Excentro document tree structure or guilloche graphics paths.

PREFERENCES… (Mac OS 9)

Preferences… command (Cmd-,) could be found under Edit menu only while

Excentro runs under Mac OS 9. Under Mac OS X this command is moved to Excentro

application menu, according to new interface guidelines from Apple.

This command brings to screen Excentro Preferences dialog, where you can set vari-

ous application settings, set up vector-based application to open guilloche designs after

export or edit lists of frequently used page formats and stroke presets. Do not forget to

click Apply button before closing this dialog, if you want to put into action changes you

made to its panels and fields.

See Excentro Preferences chapter of this guide for more details about this dialog win-

dow and all Excentro application settings.
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SHOW CLIPBOARD

Show Clipboard command makes visible Clipboard window: 

■ If Clipboard window was closed or hidden it will appear on screen.

■ If Clipboard window was visible, but overlapped by other windows or mini-

mized, it will be brought forward in front of you.

Clipboard window is a special window that displays Clipboard buffer content: text,

graphics or Excentro objects that was cut or copied to it. You can use this window to

check if Clipboard has right object before pasting it back to document. You can not do

anything with this window except looking at its content and closing it afterwards.

Clipboard window with three different content types: text, graphics and Excentro object.

ZAP DOCUMENT UNDOS

Zap Document Undos command discards all previous undo-redo states for current

document. You may want to do so if application performance slows down after few

hours of work with the document, or you met low memory situation while running

under Mac OS 9.

By default Excentro keeps all user actions in memory from the moment when document

was opened or created. This feature lets you undo and redo all earlier changes at any

convenient time later. Unfortunately, after few hours of work with the document, num-

ber of entries in undo list goes over one thousand and performance slow down or low

memory problems may happen.

Undo and redo lists of the document will also be cleared when you choose Revert to

Saved command from File menu to restore the document to last state saved to file with

Save command.
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CHAPTER 3: STRUCTURE MENU

Third menu of Excentro menu bar is Structure menu. This is probably most important

menu in this reference because it handles all matters of guilloche design tree composi-

tion. Structure menu does not have similarities or analogues in other software applica-

tions or graphics tools, so you probably should pay attention and read this chapter thor-

oughly.

With commands of Structure menu you can create new bases and new elements,

change elements order and relations to their parent elements, duplicate elements and

delete ones you no longer need.

Items of the menu become active and inactive depending on current selection in

Structure pane of Excentro main document window.

Last two commands of the menu change their name and function when Shift modifier

key is pressed. This allows you to to duplicate or delete whole set of connected elements

with single command.

Most of Structure menu commands have corresponding shortcut buttons in Structure

section of Toolbar. You probably will never use menu commands directly preferring to

work with Toolbar buttons.

This chapter contains detailed reference of all Structure menu commands. Though it

contains short explanations of basic guilloche design terms, before reading this chapter

we recommend you to get familiar with main conceptions of guilloche design construc-

tion in Excentro. Please, look at introductory material in first two chapters of Using

Excentro guide. Terms like ‘structure’, ‘base’, ‘second base’, ‘element’, ‘content elements’

and ‘direction’ are explained and illustrated there in more details.
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NEW BASE

New Base command (Cmd-B) creates new base elements. ‘Bases’ are root elements of

guilloche structure tree. They are placed at top (first) level of tree hierarchy in structure

pane of main document window. All other elements ‘grow’ from these root elements

as branches and leafs of a tree. Base elements define type of guilloche design: if base ele-

ment is circle or ellipse then guilloche design is of circular type like rosette, if base ele-

ment is linear then guilloche could be band, border or background.

Base of Ellipse type is used as root element for circular rosette design.

When you choose New Base command new base element of default Ellipse type is cre-

ated and its attributes are shown in Excentro Control inspector. Now you can change

type of new base from Ellipse to whatever you like, modify its size, position and other

attributes.

Excentro Commands Reference

Chapter 3: Structure Menu

3-2



This command is always active whenever you have opened Excentro document in front

of you. 

Structure section of Toolbar has shortcut button to New Base command. You can use

this button instead of menu command with same effect.

NEW ELEMENT

You will use New Element command (Cmd-E) to create all other elements of guilloche

structure except root ‘base’ elements (these should be created with New Base com-

mand, see above). New Element command creates both: regular ‘elements’ which rep-

resent modifications of their parent element’s path, and ‘content elements’ which fill

space between paths of two parent elements. Regular ‘elements’ could be regarded as

skeleton bones that define shape of guilloche design, ‘content elements’ could be

regarded as flesh that adds texture and substance to guilloche design body.

Regular elements (shown with red) and content elements (shown with green) of simple
guilloche rosette.

To create new regular element you should select some existing element of guilloche

structure with mouse click in structure pane of main document window, then choose

New Element command from Structure menu. New element of default Sine Wave

type will be created and its attributes will be set ready for modification in Excentro

Control inspector. The element you selected with mouse click in structure pane before

using New Element command, will become parent element or ‘base’ element for newly

created element. You can change type of new element from Sine Wave to whatever you

want, modify its size, position and other attributes in Excentro Control inspector (see

picture on next page).
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Creation of content elements is similar to creation of regular elements in paragraph

above, but you should select not just one but two elements in structure pane of main

document window before using New Element command. First element that will

become parent element or ‘base’ for newly created element should be selected with sim-

ple mouse click. Second element that will become second parent element or ‘second

base’ for newly created element should be selected with mouse click modified by Shift

key. That is: click first element with mouse pointer, then hold down Shift key and click

second element, release Shift key and choose New Element command.

New content element of default Sine Wave type will be created and its attributes will

appear in Excentro Control inspector. Now you can change type, size, position and

other attributes  of new content element.
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Shortcut button to New Element command is located beside New Base button in left

part of Structure section of Toolbar.

CHANGE BASE

Change Base command allows you to change parent element of selected element in

structure pane of main document window. You can use this command to quickly

rearrange elements of the tree. For example: you want to change shape of guilloche

design by adding new modifying path to the path of existing element in the middle of

structure tree and make all other elements that branched out of this element to use new

path. To do so, create new element that modifies existing path the way you want, then

use Change Base command to reset parent element of all other elements to this new

parent.

Select element that you want to change parent of with mouse click, then hold down

Shift key and click the element that you want to become its new parent element, release

Shift key and choose Change Base command from Structure menu.

Before Change Base command: we would like to modify structure tree so that the element
(shown with gray path) will become new parent of selected element (shown with red path),

instead of its current parent element (shown with black path).
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Structure tree will be rearranged so that the selected element will become a child ele-

ment of its new parent element.

After Change Base command: structure tree was rearranged. Now the element (shown
with gray path) is the parent of selected element (shown with red path).

This command can change parent elements for both: regular element and content ele-

ments. Second parent element of content element could be changed with Change

Second Base command from Structure menu (see next command description in this

chapter).

New parent element should not depend on selected element in any way. That is: selected

element can not be a parent, second parent or direction element for the element you

want to make its new parent (or any of this element’s parents or their direction ele-

ments). Otherwise we would get impossible loop where element could be one of its own

parents. Change Base command is active only when there are will be no such impossi-

ble connections, otherwise it is grayed out.

Instead of Change Base menu command you can use drag-and-drop action in structure

pane of main document window. Select element that you want to change parent of

with mouse click, then drag its rectangular representation to the element that you want

to become its new parent element. This is probably faster and easier way to change par-

ent element than choosing a command from menu.

You can also use shortcut button to Change Base command in Structure section of

Toolbar.
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Comments: In Excentro terminology introduced in Chapter 2 of Using Excentro guide
we use term ‘base’ to refer to both: root element of structure tree and parent element of
current element. So, this command, that changes parent element, is called ‘Change Base’.
Probably, ‘Change Parent Element’ would be more appropriate title, but it is too long for
practical use. If we shall try to shorten title to ‘Change Parent’ it will become even more
obscure than ‘Change Base’, taken into account everyday usage of word ‘parent’.
‘Change Base’ could be a bit misleading for novice users who might decide that it works
only with root elements of the structure tree. Just try to keep in mind that ‘base’ in Excentro
is not only root element but also any parent element in the tree.

CHANGE SECOND BASE

Change Second Base command changes second parent element (or ‘second base’) of

content element. It does what Change Base command do with parent element of regu-

lar elements or first parent of content elements. Pair of Change Base and Change

Second Base commands allows you to rearrange position of content elements in struc-

ture tree and make guilloche design more complex. 

For example, you can add new modifying path to the path of existing element that

serves as a second parent of some content element, then use Change Second Base

command to assign it as new second parent of the content element.

Select content element that you want to change second parent of with mouse click, then

hold down Shift key and click the element that you want to become its new second

parent, release Shift key and choose Change Second Base command from Structure

menu.

Before Change Second Base command: we would like to make the element (shown with
gray path) new second parent of selected element (shown with blue path), instead of its

current second parent element (shown with black path).

Excentro Commands Reference

Chapter 3: Structure Menu

3-7



Connection lines of content element will be updated to reflect the change.

After Change Second Base command: now the element (shown with gray path) is the
second parent of selected element (shown with red path).

New second parent element should not be dependent on selected element. That is: this

element or its parent element or their direction elements should not have connections

to selected element. Change Second Base command is active only in this case.

You can use shortcut button to Change Second Base command in Structure section

of Toolbar to achieve same result.

Comments: Excentro terminology introduced in Chapter 2 of Using Excentro guide
uses term ‘second base’ to refer to second parent element of content elements. So the title of
this command is ‘Change Second Base’ rather than ‘Change Second Parent Element’
or ‘Change Second Parent’.

SWAP BASES

Swap Bases command lets you exchange parent element (‘base’) and second parent

element (‘second base’) of selected content element. This command does not have a

practical purpose for guilloche graphics design, but can help you to make document’s

structure tree more tidy and better organized.

For example, you may want to use this command to improve visibility of connection

lines, as illustrated on next page, or create additional branches of guilloche structure tree

for easier readability of Excentro document.

Select content element, whose parent element and second parent element you want to

exchange, with mouse click in structure pane of main document window, then

choose Swap Bases command from Structure menu.
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Before Swap Bases command: second parent element of content element is also a parent
element of its first parent element. We have narrow structure tree, connection line from

content element to its second parent element easily misidentified as connection line from
its first parent element to its own parent element.

Connection lines and structure position of content element will be changed accordingly.

After Swap Bases command: First and second parents of content element were
exchanged. Structure tree is wider now, connection lines from content element to its both

parents are clearly visible.
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ELEMENTS ORDER

Elements Order submenu allows you arrange positions of elements located on same

branch of document’s structure tree. Or let us put it in other words: it controls order of

elements with same parent element. Order of elements do not have effect on guilloche

graphics display. Changes in element order are only changes of guilloche tree and are

visible only in structure pane of main document window.

You can use Elements Order submenu to reorganize document structure for better

readability, so connection lines between element’s rectangular representations will be

more evident and distinguishable one from another.

To illustrate commands of Elements Order submenu let us create a simple document

with four elements having single parent — a root element of the tree. First element will

have a child element, so you could see that they change their place together. Second ele-

ment will be a parent (‘base’) and third element will be a second parent (‘second base’)

of a content element: you will see what happens to connection lines when order of par-

ent elements changes.

Now let us apply all commands of Elements Order submenu to this sample document.

Since guilloche graphics is not affected when elements order changes we will show only

structure pane of main document window on our pictures.
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SET AS FIRST

Set as First command (Cmd-Shift-Arrow Up) sets selected element as the first child

element of its parent element. The element becomes the leftmost element on its branch

as if it was created before all other elements with same parent.

To illustrate this command let us select third element of our sample document and apply

Set as First command to it.

Before Set as First command.

The element is moved to far left and became the first element of its branch. This element

is a second parent of the content element, so the connection line to the content element

is updated for new location of the element.

After Set as First command.

Comments: Set as First command is enabled only if selected element is not already the
first child element of its parent element. Otherwise this command in Structure menu is
grayed out.
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MOVE UP

Move Up command (Cmd-Arrow Up) changes places of selected element and its left

neighbor. The result of the command is the same as if Move Down command was

applied to its left neighbor.

To illustrate this command let us select fourth element of our sample document and

apply Move Up command to it.

Before Move Up command.

The element is moved to the left and its left neighbor took its place on far right of their

branch. Since its left neighbor is a second parent of the content element, the connection

line to the content element is updated for new location of the elements.

After Move Up command.

Comments: Move Up command is enabled only if selected element is not already the
first child element of its parent element. Otherwise this command in Structure menu is
grayed out.
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MOVE DOWN

Move Down command (Cmd-Arrow Down) changes places of selected element and

its right neighbor. The result of the command is the same as if Move Up command was

applied to its right neighbor.

To illustrate this command let us select first element of our sample document and apply

Move Down command to it.

Before Move Down command.

The element is moved to the right and its right neighbor took its place as the leftmost

element of their branch. Since both of these elements have child elements, they move

with them, the connection lines are updated for new location of the elements.

After Move Down command.

Comments: Move Down command is enabled only if selected element is not already the
last child element of its parent element. Otherwise this command in Structure menu is
grayed out.
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SET AS LAST

Set as Last command (Cmd-Shift-Arrow Down) sets selected element as the last

child element of its parent element. The element becomes the rightmost element on its

branch as if it was created after all other elements with same parent.

To illustrate this command let us select second element of our sample document and

apply Set as Last command to it.

Before Set as Last command.

The element is moved to far right and became the last element of its branch. This ele-

ment is a parent of the content element, so the content element was moved with it and

the connection lines are updated for new location of the element.

After Set as Last command.

Comments: Set as Last command is enabled only if selected element is not already the
last child element of its parent element. Otherwise this command in Structure menu is
grayed out.
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DIRECTION

Direction submenu contains commands that allow you to set and restore ‘direction’

element for selected element in structure pane of main document window. 

‘Direction’ element guides ‘rotation’ of the element as the element ‘moves’ along the

path of its ‘base’ element. Chapter 2 of Using Excentro guide contains illustrations of

Excentro guilloche mechanics and explains terms like ‘direction’ and ‘base’ in more

details.

By default the element uses its base element as direction element, but in some cases it

seems appropriate to set another element as direction element. These cases are:

■ When base path has too many twists and coils you can set up simpler path (usu-

ally the path that belongs to the parent element of its parent element or the root

element of its tree structure) to control element’s rotation and avoid unwanted

coils.

■ When base path is not a smooth curve or has sharp corners (like root elements

of rectangle type) you can set up different element with smooth path to guide ele-

ment’s rotation and avoid sudden jumps and path breaks.

To set new direction element for selected element you can use Set command of

Direction submenu. To restore direction element to parent element of selected element

you can use Restore command of Direction submenu.

SET DIRECTION

Set command of Direction submenu allows you to set another element as direction

element of selected element. To illustrate this command let us create simple example

document with just four elements: root base of Circle type, Sine Wave element on sec-

ond tree level, as a child of Circle, and two Sine Wave elements on third level, as chil-

dren of first Sine Wave element (see picture on next page). Two last elements are iden-

tical at this moment with non special direction element set for either of them. As you

can see paths of these elements have too many twists and coils because their parent

Sine Wave controls their direction (so they follow all its waves). Now we will set Circle

root element, that does not have any waves, as direction element for one of these ele-

ments and see how its path changes after that.

Select the element you want to set direction element for (right one of two elements on

third level of the tree) with mouse click in structure pane of main document window,

then hold down Shift key and click the element that you want to become its new direc-

tion element (Circle root element), release Shift key and choose Set from Direction

submenu of Structure menu.
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Before Set command of Direction submenu.

Green connection line will appear between root element and selected Sine Wave ele-

ment. Guilloche path of selected element (shown with black ) will become less twisty,

because now smooth Circle path controls it direction. You can compare this path with

unchanged path of left element on third tree level (shown with gray) and see the differ-

ence.

After Set command of Direction submenu.

The element you want to set as direction element should not be dependent on selected

element. That is: this element or its parent element or their direction elements should

not have connections to selected element. Set command of Direction submenu is

active only in this case.
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You can use shortcut button to Set command of Direction submenu in Toolbar. This

button is located in right part of Structure section of Toolbar beside Change Second

Base button.

RESTORE DIRECTION

Restore command of Direction submenu to restores direction element of selected ele-

ment to its parent element. Select the element with direction element (set by Set com-

mand of Direction submenu) with mouse click in structure pane of main document

window and choose Restore from Direction submenu. Green connection line will

disappear and guilloche graphics will be updated to reflect the change. You can use pic-

tures on previous page to see how structure pane and guilloche paths of sample docu-

ment look with or without direction element set.

Shortcut button to Restore command of Direction submenu is located in right part of

Structure section of Toolbar.

DUPLICATE ELEMENT

Duplicate Element command (Cmd-D) allows you to create an exact copy of select-

ed element in structure pane of main document window. Select element you want to

duplicate with mouse click, then choose Duplicate Element command from

Structure menu.
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A copy of selected element will be created and added to right end of same branch of

structure tree. All attributes values, Step&Repeat sets and connections to parent ele-

ments and direction elements will be duplicated.

After Duplicate Element command: selected element was duplicated, its child content
element was not.

If selected element has child elements, these elements will not be duplicated by

Duplicate Element command. If you want to duplicate child elements too (and all

their child elements), you should use Duplicate All Elements command (described

below) instead.

You can use shortcut button to Duplicate Element command in Structure section of

Toolbar.

DUPLICATE ALL ELEMENTS

When Shift key is pressed Duplicate Element command becomes Duplicate All

Elements command (Cmd-Shift-D). You can use this command to duplicate not only

selected element in structure pane of main document window, but all of its child ele-

ments and all child elements of these child elements, if they exist.

Connections between child elements are preserved by Duplicate All Elements com-

mand. That is: if some of child elements had connections between each other as parents,

children or direction elements, then copies of these elements will have similar connec-

tions between them.

Select element you want to duplicate with all its child elements by mouse click in struc-

ture pane of main document window, then choose Duplicate All Elements com-

mand from Structure menu (see picture on next page).

Excentro Commands Reference

Chapter 3: Structure Menu

3-18



A copy of selected element and its children elements will be created and added to right

end of same branch of structure tree. All attributes values, Step&Repeat sets and connec-

tions to parent elements and direction elements will be duplicated.

After Duplicate All Elements command: selected element and its child content element
were duplicated.

DELETE ELEMENT

Delete Element command deletes selected element in structure pane of main docu-

ment window. This command is similar in effect to Clear command of Edit menu but

has additional benefit of shortcut button in Structure section of Toolbar.
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As with Cut or Clear commands, you can not use Delete Element command on

selected element if some other elements are dependent on this element. That is: if this

element has children elements or any element use it as direction element. Delete

Element command is inactive and grayed out in this case. You should delete all ele-

ments that depend on selected element or change/remove their connections to it before

using Delete Element command to delete it. Or you can use Delete All Elements

command (see below) to delete selected element with all its children elements.

Following picture illustrates cases when Delete Element command could be used:

Two bottom elements do not have other elements that depend on them. Only they could be
deleted with Delete Element, Clear or Cut commands.

DELETE ALL ELEMENTS

Delete All Elements command allows you to delete selected element in structure pane

of main document window together with its children elements (and children of

these children). You can achieve same results if you will delete these children elements

first with Delete Element command and then use Delete Element command to

delete selected element. You can not use Delete All Elements command on selected

element if some other elements, that are not its children or children of these children,

depend on this element or its children elements. Delete All Elements command is

inactive and grayed out in this case. You should delete all elements that depend on

selected element or its children elements and change/remove their connections to them

before using Delete All Elements command.
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Content elements are counted as children of their first parent element only, they depend

on their second parent element but are not direct children of it. As a result you can not

use Delete All Elements command or Delete Element command on their second

parent element.

Following picture illustrates cases when Delete All Elements command could be used:

Delete All Elements command could be used only on the elements with green solid frame.
Two elements with dotted red frame can not be deleted because they are used as second

parent element and direction elements for elements that are not their direct children. Two
elements without border can not be deleted because their children with red dotted border

can not be deleted.
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CHAPTER 4: ARRANGE MENU

Fourth menu of Excentro menu bar contains commands that change front-to-back

drawing order of guilloche tree objects in Excentro document. Similar result could be

achieved with drag-and-drop manipulations with rectangular object representations in

layers list of main document window.

With Arrange menu commands you can change layers list position for selected object

gradually: one step up or one step down, or rapidly: straight to the top or straight to the

bottom of the layer object belongs to. For movement of the object to arbitrary position

in layers list, drag-and-drop actions present a better option.

Benefits of Arrange menu commands are their keyboard shortcuts that allow to quickly

change drawing order position of the object after selecting its paths in document pre-

view window — no need to locate proper object in layers list and figure out where to

drag it to.

When you change object position in layers list (and its front-to-back drawing order)

its paths in document preview window will appear above paths of the objects locat-

ed below it in layers list, overlapping them, and below paths of the objects located

above it in the list.

You can not move object to different layer with both Arrange menu commands and

drag-and-drop actions. Copy-Paste commands combination from Edit menu should

be used in this case instead.

To illustrate changes that could be accomplished with Arrange menu commands let us

create simple guilloche design with five visible objects (see picture below). The selected

object with thick blue path will be located in the middle of layers list for the start. Two

elements with green paths have positions below the selected object, two content ele-

ments with purple and yellow paths are above it. On next pages we will see how

Arrange menu commands change selected object position and preview of our guil-

loche design.
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BRING TO FRONT

Bring to Front command (Cmd-Shift-]) moves selected object of Excentro document

to top position in its layer’s object list, making it the first object in front-to-back drawing

order for this layer. Paths of other objects in same layer will be located beneath the path

of selected object, overlapped by it.

Next picture shows how objects and paths of this chapter example will be rearranged

after Bring to Front command will be applied to selected element. Thick blue path will

be located above paths of all other objects. The same results could be achieved with

drag-and-drop action shown with dotted arrow.

Comments: Bring to Front command is enabled only if selected object in Excentro doc-
ument window is not already top object in its layer’s objects list. Otherwise this command
in Arrange menu is grayed out.

BRING FORWARD

Bring Forward command (Cmd-]) moves selected object of Excentro document to

position one step higher in its layer’s object list, placing it above the object that was

above it before this command. Paths of these two objects will exchange places in front-

to-back drawing order for this layer.
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Picture above shows how objects and paths of this chapter example will be rearranged

after Bring Forward command will be applied to selected element. Thick blue path

will be placed above yellow paths of content element it was below before the command

and only purple paths of second content element will be overlapping it. The same results

could be achieved with drag-and-drop action shown with dotted arrow.

Comments: As with Bring to Front command, Bring Forward is enabled if selected
object in Excentro document window is not already top object in its layer’s objects list.
Otherwise this command in Arrange menu is grayed out.

SEND BACKWARD

Send Backward command (Cmd-[) moves selected object of Excentro document to

position one step lower in its layer’s object list, placing it beneath the object that was

below it before this command was applied. Paths of these two objects will exchange

places in front-to-back drawing order for this layer.

Next picture shows how objects and paths of this chapter example will be rearranged

after Send Backward command will be applied to selected element. Thick blue path

will be placed beneath wider green path of the element it was above just before Send

Backward command was applied and only second smaller green path will remain

under it. The same results could be achieved with drag-and-drop action shown with dot-

ted arrow.

Comments: Send Backward command is enabled only if selected object in Excentro
document window is not already at the bottom of its layer’s objects list. Otherwise this com-
mand in Arrange menu is grayed out.

SEND TO BACK

Send to Back command (Cmd-Shift-[) moves selected object of Excentro document

to bottom position in its layer’s object list. The object becomes the last object in front-

to-back drawing order for this layer. Paths of other objects in same layer will be located

above the path of selected object, overlapping it.
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Next picture shows how objects and paths of this chapter example will be rearranged

after Send to Back command will be applied to selected element. Thick blue path will

be located beneath paths of all other objects. The same results could be achieved with

drag-and-drop action shown with dotted arrow.

Comments: As with Send Backward command, Send to Back command is enabled if
selected object in Excentro document window is not already at the bottom of its layer’s
objects list. Otherwise this command in Arrange menu is grayed out.
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CHAPTER 5: VIEW MENU

View menu of Excentro contains commands that control display of guilloche graphics

in document preview window of current document.

Commands in the menu can be divided into three sections:

1. Document Zoom section groups first six items of View menu. These com-

mands change magnification value at which graphics in document preview

window is displayed. You can use these commands to enlarge preview of guil-

loche design when you need to see more details or reduce it when you want to fit

all graphics into single window. These commands correspond to buttons and con-

trols with similar names in Document Zoom section of Excentro Toolbar.

You can use both menu commands and Toolbar buttons with same effect. Menu

commands have additional benefit of keyboard shortcuts that present a simpler,

faster way to achieve same result i.e. change document zoom quickly with com-

mand keys combination (These are particularly helpful if you want to zoom in or

zoom out on central part of the window with Cmd-= and Cmd-- keys.)

2. Redraw section. You will not normally use these two commands. One of them

redraws visible guilloche paths in document preview window, second com-

mand recalculates all guilloche paths of current document and draws visible

paths to document preview window as it calculates then (the process is similar

to what happens when you open Excentro document for the first time). You can

use these commands if you believe that something is wrong with display of docu-

ment preview, for example, if your display graphics card does not work properly

with present Mac OS version or you want to be sure that paths display is correct.

3. Appearance section combines three last commands of View menu. These

commands change appearance of guilloche graphics paths in document pre-

view window. You can choose between color mode with realistic paths thickness

or wireframe skeleton black and white mode; show or hide document grid; show

or hide nodes of spline segments paths consist of. You can turn on and off these

options to your personal liking or switch between them at different stages of guil-

loche creation process.
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ACTUAL SIZE

Actual Size command (Cmd-1) sets magnification value of current document pre-

view window to 100%. This allows you to see graphics at its ‘real size’, not in zoomed in

or zoomed out state.

The button with large page picture in the middle of Document Zoom section is the

Toolbar equivalent to Actual Size menu command.

After Actual Size command was chosen, check mark appears right to this item in View

menu, the button in Toolbar appears in selected (pressed) state, until you will set other

magnification value.

Comments: ‘Actual size’ is not a best name for 100% magnification value because mod-
ern display technology made possible production of high resolution CRT and LCD monitors
with pixel size smaller than 1/72 inch, so the graphics you see on screen will appear small-
er than final paper document (if final document will be printed and placed beside the
computer screen with same graphics design). Still, since other graphics software tools have
similar name for 100% value its usage and graphics size will be consistent throughout all
page layout and graphics design applications.

FIT PAGE

Fit Page command (Cmd-0) calculates and sets new magnification value so that whole

page size of the document fits into document preview window. You can use this

command if you want see overview of all document graphics content quickly.

The button with framed page picture beside Actual Size button in Document Zoom

section is the Toolbar equivalent to Fit Page menu command.

Check mark appears beside Fit Page command when this command was selected, the

Toolbar button appears in selected (pressed) state, until magnification value or window

size will be changed.
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FIT WIDTH

Fit Width command (Cmd-2) has similar effect to Fit Page command but it uses only

horizontal page size dimension (width of the document) to calculate and set new mag-

nification value. When you choose this command, document preview will be scaled to fit

width of the document into its document preview window. After that you will be

able to see whole document content using only vertical scroll actions.

The button with framed page top in right area of Document Zoom section is the

Toolbar equivalent to Fit Width menu command.

Check mark appears beside Fit Width command when this command was selected, the

Toolbar button appears in selected (pressed) state, until magnification value or window

width will be changed.

Comments: Fit Width command and Fit Page command has same purpose — to show
more of document content with single menu command or single button click, but Fit
Width command usually sets larger magnification values that allows you to see more
graphics details.

ZOOM IN

Zoom In command (Cmd-=) selects next magnification value from predefined magni-

fication values list. Excentro has following predefined values: 6.25%, 12.5%, 25%, 50%,

75%, 100%, 200%, 400%, 800%, 1600%, 3200%, 6400%. For example, if you choose Zoom

In command when document preview window has magnification value 105% or

120%, new 200% value will be selected from the list (because 105% or 120% larger than

100%, but smaller than 200%) and document preview will be scaled to reflect this value.

Same result can be achieved with + button from Excentro Toolbar.

Comments: When you reach maximum value of 6400% no further magnification is pos-
sible and Zoom In command and + button of Toolbar become inactive.
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ZOOM OUT

Zoom Out command (Cmd--) has opposite effect to Zoom In command: it selects

previous magnification value from predefined magnification values list: 6.25%, 12.5%,

25%, 50%, 75%, 100%, 200%, 400%, 800%, 1600%, 3200%, 6400%. For example, if you

choose Zoom Out command when document preview window has magnification

value 105% or 120%, new 100% value will be selected from the list (because 105% or

120% smaller than 200%, but larger than 100%) and document preview will be scaled to

reflect this change.

Same result can be achieved with - button from Excentro Toolbar.

Comments: When you reach minimum value of 6.25% no further zooming out is possible
and Zoom Out command and - button of Toolbar become inactive.

ZOOM

Zoom submenu allows you to explicitly select magnification value for document pre-

view window from predefined list: 6.25%, 12.5%, 25%, 50%, 75%, 100%, 200%, 400%,

800%, 1600%, 3200%, 6400%. Check mark will appear beside the value after you selected

it from the submenu.

Last Other… item of Zoom submenu calls up Zoom To dialog, where you can type new

desired magnification value in Magnification field.
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You can also select one of predefined values from popup menu that accompanies

Magnification field. These are the same predefined values as in Zoom submenu, so it is

not required to use Other… command and Zoom To dialog just to select one of these.

After you finished with magnification value selection in Zoom To dialog, you can click

OK button to apply new value or Cancel button to close dialog and return to previous

value.

Toolbar have similar magnification value field and popup menu with predefined values

that could be used instead of items in Zoom submenu or Zoom To dialog.

REDRAW

Redraw command redraws visible guilloche paths in document preview window.

You can use this command if you believe that something is wrong with display of docu-

ment graphics, for example, if your display card drivers do not work properly with pres-

ent Mac OS version and you see unpleasant artifacts when you switch between windows

and applications. Sometimes something like that could be noticed when you use appli-

cations in Classic mode under Mac OS X operation system — parts of the window that

was overlapped by other windows remain white after you selected it. With Redraw

command you can force redrawing of all visible area of document preview window.

Comments: Both Mac OS X and Excentro employ window buffering mechanism to dis-
play graphics on screen. This way annoying flickering at window update time (when win-
dow’s content is erased first then drawn again) could be avoided. This also means that if
graphics in document preview window was displayed correctly, you will not notice a
difference before and after Redraw command was applied.
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RECALCULATE

Recalculate command (Cmd-R) recalculates all guilloche paths of current document

and draws visible paths to document preview window as it calculates them (the

process is similar to what happens when you open Excentro document for the first time

and guilloche paths are created from document tree-like elements structure). You can

use this commands if you believe that something is wrong with document graphics and

you want to check if it was properly calculated.

Comments: This command was added to View menu for development purpose original-
ly, then we decided to keep it ‘just in case’. Another amusing usage for this command is to
check how fast different Macintosh systems perform complex mathematics calculations:
you can type Cmd-R and measure duration of document graphics recalculation with stop-
watch to benchmark computers around you.

WIREFRAME/PREVIEW

The name of this command (Cmd-Y) toggles between Wireframe and Preview

depending on current document preview window mode:

■ If the document preview window is in realistic preview mode, that shows

actual path colors and stroke weights at selected window magnification value, the

command name is Wireframe and you can use it to switch to skeleton wireframe

mode.

■ If the document preview window is in skeleton wireframe mode, that shows

all visible graphics as uniformly 1 pixel black paths, the command name is

Preview and you can use this command to switch back to realistic preview mode

(see picture on next page).
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Besides the document preview mode that you can control with this command, each

layer of Excentro document may have its own preview mode that could be changed with

mouse click on layer mode icon. Layers may also be in one of two modes: realistic pre-

view mode that shows actual path colors and stroke weights (indicated with small black

square) or wireframe mode that shows skeleton 1 pixel black paths (indicated with

small empty square). Layers modes are used only when the document is in preview

mode. When the document is in wireframe mode all paths are shown as 1 pixel black

regardless of preview mode of the layer they belong to.

Comments: You can use preview and wireframe modes on different stages of guilloche
design process: when you create basic guilloche geometry wireframe mode can give better
illustration of paths shape and intersections, alternatively, when you specify colors and
stroke thickness at final steps of guilloche creation, preview mode shows the actual picture.
Wireframe mode is a faster mode, because it gives fewer graphics details, so if you are
working on complex design you can switch to this mode to save some time on graphics
updates in document preview window.
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SHOW GRID/HIDE GRID

Show Grid command turns on visibility of grid in document preview window. After

that, the command name changes to Hide Grid and selecting it once more will switch

grid off again.

When grid is visible sizing and positioning of objects could be easier tasks to do. Grid

size and color can be changed in Document Grid section of General panel in

Excentro Preferences dialog.

SHOW NODES/HIDE NODES

Show Nodes/Hide Nodes command turns on and off preview of ‘path nodes’ — small

dots that show joints of spline segments guilloche path consists of. Visible nodes give

you overview of vector paths as they will be exported in Adobe Illustrator format.

Experienced user can use this preview to avoid occasional paths generation defects like

loops or corners that sometimes can result from certain problematic object attributes

combination.
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If document and layer are in realistic preview mode (mode that shows colors and stroke

weights of guilloche paths) you can see only nodes of paths that belong to selected

object and its step & repeat set.

Guilloche graphics in preview mode Same guilloche with visible nodes

When document or layer are in wireframe mode (mode that shows all paths as skeleton

1 pixel black graphics) nodes of all visible paths are shown at once.

Guilloche graphics in wireframe mode Same guilloche with visible nodes

Comments: Number of nodes the path of selected object consists of is shown in bottom
area of Path panel of Excentro Control inspector (see picture on next page). You can
not manually specify this value or edit individual spline segments in Excentro. All guilloche
paths creation issues are indirectly controlled by object attributes and its place in objects
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hierarchy. If you want, you can edit spline segments and nodes of the paths in any vector-
based illustration design package later, after guilloche graphics is exported in Adobe
Illustrator format.
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CHAPTER 6: WINDOW MENU

Just like any other Macintosh application that works with multiple windows, Excentro
has a special menu to manage and arrange all document and utility windows. This is

Window menu. You are probably already familiar with most of this menu commands

since they are the same as in other applications that comply to Mac OS user interface

guidelines from Apple.

Window menu looks slightly differently under Mac OS 9 and Mac OS X operating system

environments. Mac OS X version uses another terminology (e.g. Minimize Window

instead of Collapse Window) and adds special command Bring All to Front to

reflect changed application windows behavior under this Mac OS version.

There are three different groups of commands in Window menu:

■ Top two items of the menu change size of document windows. They can either

collapse window to its title bar (under Mac OS 9) or minimize window into appli-

cation dock (under Mac OS X) and vice versa increase window’s size to it maxi-

mum.

■ Commands in second menu section are used to manipulate special utility win-

dows of Excentro application. You can change visibility, appearance or size of

Toolbar, show or hide inspector windows like Excentro Control, Property

Inspector, Color Mixer or open windows that belong to swatch palettes.

■ Bottom sections of the menu help to arrange all opened document windows

positions on computer screen and to select any Excentro document from the list of

opened documents. After the document is selected from this list, its windows are

brought forward to be positioned in front of all other document windows, so you

will be able to work with them. Dots, diamonds, and check mark symbols are used

to indicate changed, collapsed/minimized and currently selected documents in

the list. The meaning of these symbols is the same as in other Macintosh applica-

tions as specified by Apple.

Rest of this chapter contains detailed reference of all Window menu commands.
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COLLAPSE/UNCOLLAPSE WINDOW (Mac OS 9)

MINIMIZE WINDOW (Mac OS X)

This command (Cmd-M) allows you to temporarily collapse current document window

to its title bar (Mac OS 9) or minimize it into icon in the application dock (Mac OS X).

You may want to do so, if you do not need to look at the window contents or work with

this window at the time, but you are not prepared to close this document completely.

Under Mac OS 9 the command title is Collapse Window. When you choose it, content

of the current window will be hidden from view and size of the window will be reduced

to its title bar. After that the command title will be changed to Uncollapse Window

and choosing it again will restore window to its original size.

Before Collapse Window command: both windows of Excentro document are visible at
their normal size.

After Collapse Window command: main document window was collapsed to its title bar.
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Under Mac OS X the command title is Minimize Window and when you choose it, the

current window will be minimized into application dock.

After Minimize Window command: main document window was minimized into icon in
Mac OS X application dock.

Collapsed/minimized windows are shown with diamond symbols in document win-

dows list in bottom part of Window menu. To restore these windows to their original

size you can either choose their titles from document windows list in Window menu or

click that window’s collapse box (Mac OS 9) or window’s icon in application dock (Mac
OS X).

COLLAPSE ALL WINDOWS (Mac OS 9)

MINIMIZE ALL WINDOWS (Mac OS X)

This command (Cmd-Option-M) has same position in Window menu as Collapse

Window/Minimize Window command, but is available when keyboard’s Option key

is held down. It serves similar purpose as well, but operates on all open windows, not

just the current one: 

■ Under Mac OS 9 after this command was chosen contents of all open windows

is hidden from view and windows size is reduced to title bars.

■ Under Mac OS X after this command was chosen all open windows are mini-

mized into application doc icons.

After Minimize All Windows command: all four windows of two Excentro documents
were minimized into Mac OS X application dock.
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ZOOM WINDOW

Zoom Window command resizes current window to its maximum size that fits the

monitor screen. You can use it if you want to see quickly as much of window content as

possible. Choosing this command again will return current window to its original size.

Comments: This command behavior is similar to mouse click in window’s zoom box
(shown with circles on pictures below).

TOOLBAR

Toolbar submenu of Window menu controls appearance and visibility of Excentro
Toolbar.

Toolbar is a special utility window that hosts buttons with shortcuts to most frequently

used items of Excentro menus. Toolbar can be either hidden or visible, anchored or

unanchored. Buttons and controls in Toolbar are grouped into five sections based on

their functionality: Commands, Structure, Document Zoom, Tools and Memory

Status. Last section Memory Status is visible only under Mac OS 9 operating system,

because Mac OS X system architecture does not have application memory limitations of

its earlier predecessors.

Toolbar submenu allows you to configure Excentro Toolbar to your personal prefer-

ences.
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SHOW/HIDE TOOLBAR

Show/Hide Toolbar command does what it name suggests: makes Toolbar either visi-

ble or hidden. You may want to hide Toolbar if you need few additional pixels of com-

puter screen to position document windows and do not want Toolbar to float around

with other Excentro utility windows. In this case you will have to use menu commands

or their keyboard shortcuts explicitly without benefits of Toolbar buttons. The com-

mand title reflects current state of Toolbar: if it is hidden, menu title is Show Toolbar,

if Toolbar is visible, it is Hide Toolbar.

ANCHOR/UNANCHOR TOOLBAR

While Toolbar is anchored it is ‘glued’ to top left corner of computer screen, just below

the menu bar. You can not move it from that location or position document and utility

windows so that they overlap the area occupied by Toolbar. This is default option for

Toolbar because it makes it more convenient to use.

When Toolbar is unanchored it floats above document windows just like inspectors

and other utility windows. You can position it wherever you like on your monitor. This

way you can free few pixels in top left corner without hiding Toolbar window from

view. But it also makes it more difficult to click Toolbar buttons with mouse pointer.
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TOOLBAR SECTIONS

Toolbar has five sections that group buttons and controls according to their purpose.

You can use Toolbar submenu to show or hide any of them. When you choose section

title from the submenu, Toolbar window size changes to accommodate buttons of this

section and they become visible. If you choose this section title again, it disappears and

Toolbar window size shrinks back. You can also hide unwanted Toolbar sections with

small ‘x’ button beside the section name in Toolbar window. Check mark symbol indi-

cates visible sections.

■ Commands is the first Toolbar section. It contains four buttons with shortcuts

to most frequently used commands of File menu. They help you to create new

documents, locate and open existing documents, save changes and export guil-

loche designs to Adobe Illustrator format with single button click.

■ Structure is the second Toolbar section. It contains shortcuts to commands of

Structure menu. With these buttons you can do all guilloche construction opera-

tions without ever going to Structure menu. Button’s icons also give you addi-

tional visual feedback as to what this button and its command action does, that

helps you to choose proper action faster.

■ Document Zoom section has shortcuts to zoom commands from View menu.

These commands help you to set magnification for graphics in preview document

window. Numeric magnification field also informs you about current magnifica-

tion value that preview window of selected document has.

■ Tools section allows you to select current tool to be used on graphics in preview

document window. After new tool is selected mouse cursor in preview window

changes accordingly.

■ Memory Status is the last section of Toolbar. It informs you about current

Excentro memory usage, so you could avoid low memory situations before they

arise and take appropriate actions: close some windows or zap document undos.

Comments: Memory Status section is not used or visible under Mac OS X operat-
ing system because application memory handled differently under this more
advanced operating system and frequent low memory situations are unlikely to
happen.

Toolbar chapter of Excentro Windows Reference guide contains more detailed

description of Toolbar window and its sections.
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INSPECTORS

Inspectors submenu of Window menu manages special utility windows of Excentro
application called ‘inspectors’. Inspector windows floats above document windows.

They are used to set or change properties and attributes of objects in Excentro docu-

ments.

Inspectors submenu shows or hides individual inspectors. When inspector is not visi-

ble, choosing it title from the submenu will bring its window to screen. Check mark sym-

bol will appear beside its title in Inspectors submenu after that. Choosing it from the

submenu again will hide the inspector and check mark beside its title will disappear. You

can also hide inspector window with mouse click in its window’s close box. Inspector

windows save their screen positions in application preferences file, so when they

become visible again they will reappear in same location they occupied before they were

hidden.

There are three inspector windows in Excentro:

■ Excentro Control is the ‘chief’ inspector. It controls attributes of guilloche

objects in document windows as well as properties of their graphics paths. You

probably will never want to hide this inspector from screen (and as a result will

never call it back again).

■ Property Inspector is a companion to Excentro Control. It helps to change

attribute values gradually with a scroller after specifying them roughly with

numeric fields of Excentro Control. Property Inspector could be summoned

to screen either from Inspectors submenu or from pop-up menu of Excentro

Control window.
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■ Color Mixer is where you experiment with new color values before setting

them to objects or adding them to document color list. You can either call this

inspector with Inspectors submenu or just by double clicking any color color

field or patch in document window, Excentro Control inspector or swatch

palette.

See appropriate chapters of Excentro Reference guide for detailed description of each

inspector.

SWATCH PALETTES

Swatch Palettes submenu of Window menu lets you open Swatch Palettes: special

utility windows with predefined sets of colors like color libraries.

Swatch Palettes windows floats above document windows just like inspectors and

Toolbar. They are used to set color attributes of guilloche paths or add colors to colors

lists of Excentro documents.

Examples of Swatch Palette windows with industry standard color libraries.

Excentro allows you to use three types of files as Swatch Palettes:

■ Excentro document files. in this case colors list of the document is shown in

Swatch Palette window in more compact and convenient way compared to

usual color list in main document window. Swatch Palette also have read-only

attribute, so you can avoid occasional unwanted changes of color values.
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■ Color libraries in EPS format, like once created with spectrophotometer and

special software like ColorShop. You can also use just any EPS format files with spot

colors exported from graphics editing software applications.

■ Adobe Illustrator files and color libraries saved in EPS format (not in Adobe
Illustrator PDF format, if you are using Adobe Illustrator version 9 and higher be

sure to resave files in format compatible with version 8 and earlier). In this case

swatch list of Adobe Illustrator file will appear in Swatch Palette window.

There is a special location on your hard disk where you can keep frequently used color

library files. It is ‘Swatch Palettes ƒ’ folder that should be located in same folder as

Excentro application. Files of three types defined above found in this folder are automat-

ically checked at application start up and listed in Swatch Palettes submenu. You can

open any of these files by choosing its name from the submenu. Check mark symbol will

appear in Swatch Palettes submenu beside opened file name. Choosing this file again

from the submenu will not close the open palette window, like it happens with inspec-

tor windows, but will bring this window in front of you. After you added new files to

‘Swatch Palettes ƒ’ folder, please, restart Excentro application to see them listed in

Swatch Palettes submenu.

When you install Excentro application for the first time ‘Swatch Palettes ƒ’ folder con-

tains just one file named ‘Default’. This is Excentro document with default color list that

gets automatically added to any new created documents. You can edit colors in this doc-

ument by opening it with Open command from File menu, or specify another file to be

used in its place with Swatch Palette window menu.

You can also use as Swatch Palette any file of proper file type located in other folders

on your hard disks or and network. To do so, choose Other… command from Swatch

Palettes submenu. Standard file navigation dialog will appear where you can select the

file you want to use as Swatch Palette.

See Swatch Palettes chapter of Excentro Reference guide for detailed description

on Swatch Palettes usage in Excentro.
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BRING ALL TO FRONT (Mac OS X only)

Bring All to Front command appears in Window menu only when Excentro is used

with Mac OS X operating system version. Mac OS X application windows behavior is dif-

ferent from that of earlier versions of operating system: now a window that belongs to

one application can be positioned between windows of other applications and selecting

single document window does not bring the rest of this application document windows

to foreground with it. With Bring All to Front command you can change front-to-

back windows order so that all document windows of Excentro will be positioned in

front of document windows that belong to other applications. This command is not

needed with Mac OS 9 since all Excentro document windows are automatically brought

to foreground when you switch to Excentro from other applications.

Before Bring All to Front command: after user switched to Excentro from other applica-
tion (Safari) window of first Excentro document is brought to foreground, window of sec-

ond Excentro document is still far in background, below windows of other application.

After Bring All to Front command: windows of both Excentro documents are positioned
above windows of other applications.
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ARRANGE IN FRONT

Arrange in Front command is located in Window menu below special windows sec-

tion and above document windows list. Under Mac OS X operating system it shares this

position with Bring All to Front command. You can switch between these two com-

mands by pressing Option key. When Option is not pressed, you see Bring All to

Front command, when Option is held down, it is Arrange in Front command.

Arrange in Front command helps to organize Excentro document windows. After you

will select this command all opened document windows will be resized and positioned

as if they were closed and then reopened again in same order. Main document window

and preview window of same document will be placed side by side in windows stack

formed by different document windows.

Before Arrange in Front command: windows of three Excentro documents has arbitrary
size and position on the screen, usual situation after few hours of work in Excentro.

After Arrange in Front command: windows of all three documents are neatly resized and
stacked preserving their front-to-back order.
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DOCUMENT WINDOWS LIST

Document Windows List is the last section of Window menu. It is initially empty

when you start Excentro application, then, as you open existing or create new docu-

ments, it grows and contains list of all open documents. It is rather a documents list,

than a windows list, since each item of the list corresponds to title of single Excentro
document with two of its windows (main document window and preview window). You

also can regard this list as a list of main document windows of open Excentro docu-

ments, with their companion preview windows ignored. New items are added to the

bottom of the list, so the list reflects history of documents opening/creation, not front-

to-back order of document windows.

You can use this list to select any of presently opened documents: just choose its title

from the list and both of this document windows will appear in front of you.

Marks to the left of document titles have following explanation:

Check mark indicates current selected document. It is the document with top-

most windows, the one you work with. When you select another document by

choosing its title from document windows list or by clicking one of its windows,

check mark will change its position accordingly.

Diamond indicates documents with collapsed/minimized windows. You can

restore windows of these documents to full size again by choosing its titles from

the document windows list. Diamond reflects the state of main document win-

dows only, if preview windows of Excentro documents are collapsed/minimized,

this state is not shown with diamond in the list.

Dot indicates documents with unsaved changes. When you do any changes to

Excentro document that require this document to be saved before closing its win-

dows, dot appears beside its title in document windows list. After you save the doc-

ument with Save command from File menu dot will disappear again. Dot is not

shown beside the title of current document or titles of documents with col-

lapsed/minimized windows even if they have unsaved changes, because check

mark or diamonds (see above) are already shown in place where dot could be.
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CHAPTER 7: APPLE MENU

Apple menu is the leftmost menu of every Macintosh application. 

Under Mac OS X operating system version Apple menu contains only system commands

like Software Update, System Preferences, Restart or Shut Down. We will not

cover Mac OS X version of Apple menu in this reference because it does not contain any

menu items specific to Excentro. Please, see Mac OS X Help for more information about

Mac OS X Apple menu commands.

Under Mac OS 9 Apple menu usually contains few informational items specific to cur-

rent application (in our case it is Excentro application) and a list of applications and

desk accessories located in system’s Apple Menu Items folder. This chapter describes

informational items added to Mac OS 9 Apple menu by Excentro.

Excentro adds two items to Mac OS 9 Apple menu when it runs in full functional mode:

About Excentro… command, that displays About Excentro window and Excentro

Web Page… command that points your browser to web page with news and general

information about Excentro application on Excourse web site.

When Excentro runs in demonstration mode there is additional item in Mac OS 9 Apple

menu: Purchase Online… command that could be used to access online store where

you can purchase full Excentro license with credit card. After Excentro is purchased and

registered with individual serial number this item is no longer needed and disappears

from Apple menu automatically.

All these commands are moved to Excentro Application menu, when Excentro runs

under Mac OS X operating system version. See next chapter of this reference for infor-

mation about Mac OS X Excentro Application menu and its commands.
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ABOUT EXCENTRO… (Mac OS 9)

About Excentro… command brings to screen About Excentro window. This window

shows string with version number for your copy of Excentro and scrolling string with

copyright information and credits. It also shows string with internet address of Excentro
page at Excourse web site. If you click this line with mouse pointer your web browser

will be opened and the page will be loaded automatically (see picture in section below).

EXCENTRO WEB PAGE… (Mac OS 9)

When you choose Excentro Web Page… command your web browser will be opened

and Excentro page at Excourse web site will be loaded in its window (your Macintosh
should be connected to internet to access pages on World-Wide-Web). This web page

contains latest news and general information about Excentro application. You may use

this command to check quickly if your copy of Excentro is up-to-date or if there are any

important news or announcements about Excentro from Excourse.
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PURCHASE ONLINE… (Mac OS 9)

Purchase Online… command could be found in Mac OS 9 Apple menu only when

Excentro runs in unregistered demonstration mode (with some feature limitations).

When you choose this command your web browser will be launched and order page of

online store will be opened. You can use this page to purchase full Excentro license with

credit card. Your Macintosh should be connected to internet to access pages on World-

Wide-Web.

After you purchased and registered Excentro with individual serial number Purchase

Online… command is no longer needed and will be removed from Apple menu.
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CHAPTER 8: EXCENTRO APPLICATION MENU

Just like other Mac OS X applications Excentro has a special menu located beside Apple

menu in left part of menu bar. This menu contains commands that display information

about current application, they allow you to configure application preferences, hide

application windows and quit application when you no longer need it. Title of this menu

shows name of current application, so in this reference let us call it Excentro Applica-

tion menu.

When Excentro runs in demonstration mode Excentro Application menu contains

one additional command: Purchase Online… command that could be used to access

online store where you can purchase full Excentro license with credit card.

Under Mac OS 9 there is no Excentro Application menu in Excentro menu bar. Items

form top section of this menu could be found in Mac OS 9 Apple menu, Preferences…

command is located in Edit menu, Quit command — in File menu.

ABOUT EXCENTRO… (Mac OS X)

About Excentro… command brings to screen About Excentro window. This window

shows string with version number for your copy of Excentro and scrolling string with

copyright information and credits.
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About Excentro window also shows string with internet address of Excentro page at

Excourse web site. If you click this line with mouse pointer your web browser will be

opened and the page will be loaded automatically (see picture in section below)

Under Mac OS 9 operating system About Excentro… command could be found in

Apple menu.

EXCENTRO WEB PAGE… (Mac OS X)

When you choose Excentro Web Page… command your web browser will be opened

and Excentro page at Excourse web site will be loaded in its window (your Macintosh
should be connected to internet to access pages on World-Wide-Web). This web page

contains latest news and general information about Excentro application. You may use

this command to check quickly if your copy of Excentro is up-to-date or if there are any

important news or announcements about Excentro from Excourse.

Under Mac OS 9 operating system this command could be found in Apple menu.

PURCHASE ONLINE… (Mac OS X)

Purchase Online… command will appear in Excentro Application menu only when

Excentro runs in unregistered demonstration mode (with some feature limitations).

When you choose this command your web browser will be launched and order page of

Excentro Commands Reference

Chapter 8: Excentro Application Menu

8-2



online store will be opened. You can use this page to purchase full Excentro license with

credit card. Your Macintosh should be connected to internet to access pages on World-

Wide-Web.

After you purchased and registered Excentro with individual serial number Purchase

Online… command is no longer needed and will be removed from Excentro Applica-

tion menu.

Under Mac OS 9 operating system this command could be found in Apple menu.

PREFERENCES… (Mac OS X)

Preferences… command (Cmd-,) brings to screen Excentro Preferences dialog,

where you can set various application settings, set up external vector-based application

to open guilloche designs after export or edit lists of frequently used page formats and

stroke presets. Under Mac OS 9 operating system this command could be found in Edit

menu, as was established practice prior to Mac OS X version.

Do not forget to click Apply button before closing this dialog, if you want to put into

action changes you made to its panels and fields. See Excentro Preferences chapter in

Excentro Windows Reference book for more details about this dialog and Excentro
application settings.

SERVICES (Mac OS X)

Services submenu gives you access to various Mac OS X services. This submenu is not

active or usable in Excentro application. Please see Mac OS X Help if you are interested in

what operating system services are and how to use them.
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HIDE EXCENTRO (Mac OS X)

You can use Hide Excentro command (Cmd-H) to hide all windows of Excentro appli-

cation from screen. You may want to do so if you would like to switch to some other

application and do not want Excentro windows to clutter your screen space. You can get

same result by switching to other application with Option key held down.

This command is managed by Mac OS X operating system. More details about this com-

mand could be found in Mac OS X Help.

HIDE OTHERS (Mac OS X)

Hide Others command (Cmd-Option-H) hides all windows that belong to other

applications, leaving only Excentro windows on screen before your eyes. You can use this

command when you have many applications running at the same time with a lot of

opened documents and windows. Hide Others command helps to reduce screen clut-

ter and hide all applications you are not working with at the moment.

Like Hide Excentro command, this command is managed by Mac OS X operating sys-

tem. More details about Hide Others command could be found in Mac OS X Help.

SHOW ALL (Mac OS X)

If you have any applications with windows hidden by Hide or Hide Others commands

or by switching between applications with Option key pressed, Show All command in

Excentro Application menu becomes enabled. You can use this command to make all

windows of all running applications visible on screen.

This is another command managed by operating system (not Excentro application).

More details about this command could be found in Mac OS X Help.

QUIT EXCENTRO (Mac OS X)

You will choose Quit Excentro command (Cmd-Q) to end your work with Excentro
and quit the application. Under Mac OS 9 operating system version this command could

be found in File menu as old interface rules dictate.

Before it quits, Excentro tries to close all opened documents. If closing sequence comes

to document with unsaved changes, standard warning is displayed that offers you three

options: to save changes, to discard changes or to cancel document closing and stop

quitting procedure.
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